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The modern design team does not end at the meeting room door, and by leveraging the full range of 
team collaboration tools from Autodesk, you can take your data full circle. In this class, we will look at 
delivering the promise of BIM 360 in the civil infrastructure profession by leveraging the interaction 
between AutoCAD Civil 3D, Vault Collaboration AEC, and Buzzsaw. We will start by exploring the 
internal team collaboration with Civil 3D and Vault, then submit drawings using Buzzsaw, and deliver 
feedback with the mobile AutoCAD WS platform 

Learning Objectives 
At the end of this class, you will be able to: 

 Explain the concept of BIM 360 in the civil engineering framework 

 Describe basic lifecycle concepts in the Vault Collaboration product 

 Update and review data using Buzzsaw and WS platform technology 

 

About the Speaker 

James spent nearly a decade in the Dallas/Fort Worth land development industry before entering the 
Civil 3D® consulting field in 2006. A graduate of Texas Tech with a BSCE in 1997, he worked as a 
design engineer focused on private development, designing small commercial to multiphase single 
family and master-planned communities during his time in the industry. One of the earliest gunslingers 
for the AutoCAD® Civil 3D product, James has worked extensively with the Autodesk® product team to 
shape and guide the software's development. A highly-rated repeat presenter at Autodesk University and 
co-author of the best-selling Mastering AutoCAD Civil 3D text, James joined the Autodesk team in 2010. 

james.wedding@autodesk.com 

www.twitter.com/civil3d  

www.autodesk.com/askjames 
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BIM 360 
With every project, we consume data from a thousand sources and we share our creation with a 

thousand more. As a project moves from napkin sketch to paper to model to construction 

equipment, it will changes hands over and over, sometimes as a fax, sometimes as a courier 

package, sometimes through a digital markup. At every step of the way, every time there’s a 

change in format, in owner, in process, in purpose, there’s an opportunity for loss: loss of design 

intent, loss of detail, loss of clarity. All of these little losses lead to project breakdowns and 

inefficiencies. 

BIM 360 refers to the idea that a complete, accurate, digital model of our projects, providing 

access anywhere to key information across the entire project lifecycle. This view of the world 

leads to better decision make, new insights and predictability in the project delivery, and 

improved operational reliability and efficiency. BIM 360 is an idea though, and you need tools to 

make that idea a reality. 

Within the Architecture, Engineering, and Construction, (AEC) world and in the Autodesk view, 

the tools you need are bundled up in three segments: Design, Management, and Collaboration. 

Creating models is accomplished with tools like Revit, AutoCAD Civil 3D, and 3ds Max Design. 

Management is accomplished with the Vault Collaboration AEC data manament system. 

Collaboration (outside the company walls,) is accomplished using Buzzsaw, Design Review, 

and AutoCAD WS. It’s an impressive tool collection, but with that many tools to understand and 

put together, the question quickly becomes, “How do I make this all work?” 

The Setup 
When you want to work with teams both internal and external, there are three major systems in 

play:  

1. The Design Software. This can be Revit, AutoCAD, Civil 3D, or any number of other 

design pieces. 

2. Internal Data Management. In this discussion, that’s Vault Collaboration AEC. 

3. External Data Management. In this case, Buzzsaw 

Pulling all these pieces together isnt’ terribly complicated, but it does take some setup to really 

make it work! Let’s take a look at the setup of each piece. 
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Design Software 
In the case of most Autodesk software you simply have to install the Vault client. When you do, 

you’ll see a new tab added to the ribbon as you see here: 

 

 

The commands along this 

tab are activated when you 

login to the Vault. You can 

see in this case, the Log Out 

button is active, meaning the 

user is already logged in to 

Vault. If these commands 

are greyed out, you need to 

login to the Vault system. 

Click the Log In button and 

you’ll see a dialog like this 

one. Note that you can use 

Windows Authentication if 

your Vault system is setup 

that way, and that you can 

toggle automatic login. This 

is a good suggestion if you don’t share your computer with other users and you generally are 

working in a Vault environment. 

Once you have your design software setup to work with Vault, it’s important to do some work on 

the Vault system itself to make all the pieces work together smoothly. 

Setting up the Vault System 
Before you can begin building and creating an effective Vault Collaboration system, you need to 

know who’s who and think about what you want them to be able to do. In this discussion, we 

typically need to setup Users & Groups, Categories, and Lifecycles.  
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Users & Groups 
To manage data security, you have to assign rights and privileges to some users while 

withholding them from others. In Vault, we typically do this with Security Groups. In this 

exercise, we’ll create a basic security group.  

1. Launch your Vault Collaboration application and login as a user with administrative 

privileges. 

2. Select ToolsAdministrationGlobal settings to display the Global Settings dialog. 

3. Change to the Security tab if necessary, and click the Groups… button on the right to 

display the Group Management dialog. 

4. Select New Group from the toolbar to display the group dialog shown here:’ 

 

5. Enter a group name and an e-mail if you have a distribution list setup for the group. 

6. Click on the Roles button to display the Add Roles dialog. 

7. Check the Document Editor (Level 2) option and OK to close the dialog. 

8. Click the Vaults button to display the Add Vaults dialog. 

9. Check the appropriate Vaults for access and click OK to close the dialog. 
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10. Click Add to the right of the Group Members to display the Add Members dialog. Select 

an appropriate user, click the Add button, then close the dialog by clicking OK. 

11. Click OK to close the Group dialog, then the X in the upper right to close the Group 

Management dialog.  

12. Click Close to exit the Global Settings dialog. 

If you click OK without adding a person to your group, Vault will complain about not having 

members. For this reason, I’ve often found that creating a dummy account that no one actually 

logs into is a nice placeholder and will keep your hair pulling to a minimum. You’ll want to 

actually assign users to groups as you’re creating them, but I like having the containers in place 

first.  

When you’re planning your Vault configuration, think before you create group after group. As 

you’ll see later, for every group you have, you’re adding branches on the decision tree. Keeps 

your groups to the minimum you need and your life will be better. Now we have some of the 

players established, let’s look at how they’ll work with our Vault information. 

Data Lifecycles in Vault Collaboration 
Most firms have an ad hoc lifecycle management and security system. Almost every firm has a 

horror story of a user editing files they shouldn’t have, usually leading to a costly change or a 

change in employment status. Some firms go through the hassle of setting up separate data 

shares, or even isolating files between groups, requiring survey to e-mail surface information to 

the engineering group. Regardless of the methodology, most current systems are onerous and 

cause at least as many problems as they solve. 

With Life Cycles in Vault Collaboration, you can create both a security model and an approval 

process in a semi-transparent model. A simple lifecycle could be something as simple as this: 

 

A bit of data is created, checked by the same group that created it and is then released for use 

by other groups. Even with something as simple as this, there are a lot of questions: 

 Who can edit an object that’s in a Work in Progress state? What about when it’s 

Released? 

 Who can view and object in a WiP state? Released?  

 Who can move an object from WiP to Release? What about pushing it back?  

WORK IN 

PROGRESS RELEASED 
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Even with the most basic lifecycle setup, you have to consider three major permissions: Edit 

Privileges, View Privileges, and Change State Privileges. Along the way, you can also make 

decisions about how a file should be modified with labels, updated with a new revision number, 

or published to a web server for external review. 

Let’s take a look at a more complex process, maybe something like a topographic survey might 

go through. 

In this exercise, we’ll setup this basic Lifecycle, establishing the states as shown. 

1. Select Tools AdministrationVault Settings to display the Vault Settings dialog. 

2. Change to the Behaviors tab of the dialog and click the Lifecycles… button to display the 

Lifecycle Definitions dialog as shown here: 

 

 

FOR REVIEW WORK IN 

PROGRESS 
OBSOLETE APPROVED 
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3. Click the New… button near the top to display the Lifecycle Definition dialog. 

4. Enter a name for your new lifecycle as shown and click OK. (I’m using AU Survey to 

avoid conflict with an existing lifecycle I already have in place) 

 

5. Create new states for For Review, Approved, and Obsolete. Your definition state will 

look something like this:  

 

With the general states created, you can begin to ponder how a piece of data might move 

through this process. Obviously, the linear progress would be recommended, but what about 

other options? Can an object move from Approved to For Review? From Work in Progress to 

Obsolete? 
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These options are controlled by the Transitions tab within the Lifecycle Details frame on the 

Lifecycle Definition dialog. Ideally, we want to make these changes: 

 Surveyors can move data from Work in Progress to For Review 

 Managers can more data from For Review to Approved, Work in Progress, or Obsolete 

 Managers can move data from Approved to Work in Progress or Obsolete 

 Managers can move data from Obsolete to Work in Progress 

 Administrators can move data from Obsolete to Work in Progress 

It’s a good idea to create a list like this in order to review and work through how your ad-hoc 

workflow looks in a formalized world. In this exercise, we’ll make take care of the first transition 

in our list. 

6. Within the Lifecycle Definition dialog, select Work in Progress in the Lifecycle states list, 

then click the Transitions tab on the right. Your dialog should look like this: 

 

7. Select the first line, and then click the Edit… button above to display the Transition 

dialog. 

8. Change to the Security Tab, and uncheck the “No restrictions on this transition” option. 

FOR REVIEW WORK IN 

PROGRESS 
OBSOLETE APPROVED 
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9. Click the Add… button to display the Add Members dialog, and change the dropdown list 

to Groups to help filter the options.  

10. Select the AU Users group and then click the Add button. Click OK to close the dialog 

and your Transition dialog should look like this.  

 

11. Click OK to return to the Lifecycle Definition window.  

12. Select the Work in Progress Approved row, and click Edit. 

13. Change to the Security tab and uncheck the “No restrictions on this transition” option. 

14. Click the Add button to display the Add Members dialog. 

15. Select the Everyone Group and click Add. Click OK to close the dialog. 

16. Change the Permission dropdown to Deny and click OK to close this dialog. 

It’s generally a good idea to work from top to bottom in terms of Lifecycle States, and from top to 

half-way on the Transitions. If you work the Transitions as a matter of From…To… thought 

process, you’ll find it’s easier to keep track of. Repeat the process above, setting each 

transition’s permission appropriately.  

Vault security generally works on the principal of if it’s not allowed, it’s denied. You only have to 

explicitly deny when you want an option to be available to no one, or when a subgroup might be 

part of a larger group that does have allowed permissions. For example, in our process, we 

don’t want to allow the transition from Work in Progress to Approved, so we can set that 

transition permission as shown here: 
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As you can see, adding groups and states to the lifecycle process raised the number of decision 

points exponentially. I can’t emphasize enough how much you want to think out the process 

before you just start making groups and plugging things! 

Categories in Vault Collaboration 
One of the truisms about standards is that if you make it harder to follow the standard than to 

ignore it, you’ll never achieve real standardization across the enterprise. You’ve built a number 

of lifecycles and setup the appropriate privileges for each group within the necessary states, but 

if you’re depending on users to plug files into the correct lifecycle, you’re toast. So what to do 

about it? Use Categories. 

Vault Categories allow you to assign a lifecycle to a file based on some property of that file. 

Typically this is done at creation, but you could have other factors kick in such as age, size, or 

other custom properties that would be modified in midstream. For most Civil users, the simplest 

method of filing categories is using the file name convention to slot files appropriately. In this 

example, we’ll set up an Architectural category, assign a lifecycle to that category, and establish 

rules to automatically categorize files based on a name of “A-“ 

1. Open the Vault Settings dialog, and on the Behaviors tab, click the Categories button to 

display the Configure Categories dialog. 

2. Click the New button at the top to display the Category Edit dialog. Enter the name of A-

Architecture, select a color, and enter a fitting description. 

3. Click OK to close the dialog. Select the new category in the list, and then click Assign 

below on the Lifecycle tab to display the Assign Category dialog. Select the External 

Design Release Process (or whatever your lifecycle would be,) and click Add to assign 

the appropriate lifecycle to the category. Now when a file falls into the A-Architecture 
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category, it will automatically follow the release process you’ve assigned! Your Configure 

Categories dialog will look something like this when you’re all done: 

 

4. Click Close to return to the Vault Settings dialog. 

5. Click the Rules button to display the Assignment Rules dialog.  

6. Click the new button at the top to display the Edit Rule dialog. Enter “Architect” and then 

select the appropriate Category Assignment from the dropdown list. Click OK to close 

the dialog. 

7. Select the new rule from the list and click the Property: dropdown to select “File Name” 

property, then the “Starts with” condition.  

8. Type “A-“ in the Value entry dialog and click the Add button to add the condition. Your 

rule will look something like this: 
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9. Click OK to close the Assignment Rules dialog and then the Close button to return to 

your Vault client application. 

You can make categories and lifecycles in any order you like, but you’ll need to use the Assign 

option on either end to make sure they’re tied together. Obviously, you need to pull these pieces 

together to full create a system that will manage your files as you’d like.  

With the Vault System setup for internal users, now let’s look at how we share that data with the 

outside world. 

External Data Management with Autodesk Buzzsaw 
While Vault Collaboration handles the access and sharing of interna files really well, it’s not very 

simple to attach to a vault and work remotely. One option is to poke a hole in the firewall and 

allow remote users to connect directly to the Vault, but that presents a security risk and is 

typically a very inefficient system. With the 2012 release, Vault Collaboration AEC offers a new 

functionality that will allow you to automaticall publish data to an externally hosted Buzzsaw site, 

making it easier for outside team members to access the data they need when they need it. 

Let’s look at the steps required to get this in place. 



Insert Class Title as per Title Page 

13 
 

1. Download and install the Project Sync tool from the Autodesk Buzzsaw site:  

https://projectpoint.buzzsaw.com/!Autodes/download/ProjectSync.exe 

Once installed, you will have a 

new menu item in your Vault 

Collaboration Tools menu: 

Project Sync Settings. 

2. Open the Project Sync 

Settings dialog shown here. 

Enter your Buzzsaw site name 

using the full 

https://projectpoint.buzzsaw.co

m/[YOUR SITE NAME HERE] 

format, along with a User 

Name, and Password. Setup 

the folder mapping also. 

Typically the root of your vault 

($) will match up to some 

folder on the Buzzsaw site, but 

likely not the root.  

3. Click OK. You’ll also notice 

that you have a new toolbar in 

the Vault client with options for 

Share to Buzzsaw, Update 

from Buzzsaw, and Add from 

Buzzsaw. 

4. You also need to verify that the Job Server is running on the Vault server machine. Go to 

the ToolsAdminstrationGlobal Settings and switch to the Integrations tab. Check the 

Enable Job Server option and close the dialog. If you want to verify the Job Server is 

running, go to StartAll ProgramsAutodeskAutodesk Data ManagementTools 

and select the Autodesk Job Processor for Vault Collaboration. This will show you the 

dialog here.  

 

https://projectpoint.buzzsaw.com/!/download/ProjectSync.exe
https://projectpoint.buzzsaw.com/%5bYOUR
https://projectpoint.buzzsaw.com/%5bYOUR
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5. Install the ADMS Collaboration Software Development Kit (SDK) by going to C:\Program 

Files (x86)\Autodesk\ADMS Collaboration 2012\SDK\ directory and running the 

Setup.exe package there. 

6. Now run the LifecycleEventEditor.exe found in C:\Program Files 

(x86)\Autodesk\Autodesk Vault 2012 SDK\util\LifecycleEventEditor. It looks like this after 

you login with an Administrators credentials: 

 

7. Select the Lifecycle Definition you want to assign to a Buzzsaw push, then select the 

State, and Transition that you want to CAUSE this sync. In this case, we’re setting up a 

Buzzsaw sync whenever a piece of Survey data moves from For Review to an Approved 

state. 

8. One the Transition is selected, double-click in the Job Types dialog and you have to 

TYPE the job name you want to call. There are three options: 

a. autodesk.vault.projectsync.share This PUSHES data from Vault to the Buzzsaw 

site. 

b. autodesk.vault.projectsync.update This UPDATES a Vault file from the Buzzsaw 

data (useful for outside contractor files) 

c. autodesk.vault.projectsync.add This adds a file from the Buzzsaw site that may 

not exist on the local system. 

9. Close the dialogs and close the Lifecycle Event Editor application. 

Just as a side note, if you ever want to force the Job Server to run its queue of work, launch the 

Job Processor application, and simply Pause then Resume from the File menu. 
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With all the pieces in place, you’re now ready to test, refine and flesh out your Vault 

Collaboration system. Let’s take a look at a quick day in the life of a Survey drawing and how it 

might work its way through the system. 

A Day in the Life of a Drawing 
In this scenario, let’s take a look at how a piece of data works its way into the system, gets 

approved, and is shared with the outside world. 

 Sam the Surveyor starts the process by creating a new vaulted project from within Civil 

3D. 

 He opens and adds in a topographic map using proper file naming conventions. This 

assigns a project, a data category, and a basic lifecycle state. 

 Sam works on the surface data, completes his work, and shares the surface information 

to his internal team using Vault data references. He also goes to his Vault client and 

submits the drawing for review, changing the lifecycle state, and essentially locking the 

rest of the Survey team out of the drawing until it’s reviewed. 

 Ed the Engineer starts his day by noting that a new project has been created and goes 

to look for some survey data. At this point in the Survey lifecycle, he cannot see or 

consume the Survey data, so he has to wait. 

 Melinda the Manager reviews the topographic drawing and approves it, changing the 

lifecycle state to Approved. At this point, Ed can now see the data for internal design 

use, and the project with its relevant project folder structure is now pushed to Buzzsaw. 

 Buzzsaw sends out notifications to team members when the data is uploaded, and they 

can open it via the Buzzsaw application, AutoCAD WS, or their own local design tools if 

they’ve used Buzzsaw sync. 

 An external consultant makes their data available on Buzzsaw, and Melinda uses her 

Vault client to add this data back into the Vault system, assigning categories and 

lifecycles appropriately. 

 Meanwhile, Ed has designed using the surface data and is now sharing his engineering 

data both internally and externally using Vault Collaboration AEC and Buzzsaw 

technology 

 And the day comes to a close. 

BIM 360 
As you can see, the promise of BIM 360 is making sure that the right digital model is always 

available to the right people, right when they need it. Implementing Vault Collaboration AEC is a 

step to getting there, and the changes in your projects can really pay off in the short and long 

term. 

 


